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bq78412EVM Board Quick-Start Guide

1 Introduction

1.1 EVM Features
• Evaluation module (EVM) for bq78412
• 10 LED bar graph and LED indication for status signals
• Buzzer for audible warnings
• GUI to readout measured battery voltage, current, and several internal parameters via USB interface
• Input operating range 4 V – 26 V
• Reverse polarity protection
• Includes USB-to-Serial adapter to demonstrate communication in UART and IRDA modes.
• Test points for key signals available for testing purposes. Easy probe hook-up

1.2 General Description

The bq78412 evaluation module is a complete demonstration platform for gas gauging battery
management of 12-V Pb-acid batteries used in a wide range of applications. The EVM platform consists of
two printed-circuit boards: the bq78412EVM (HPA615A) and the USB-to-Serial Adapter (HPA616A).

The bq78412 Pb-Acid Battery State-of-Charge (SoC) Indicator with Run-Time Display is a complete
stand-alone battery gas-gauge solution designed for single 12-V Pb-acid batteries. For details, see the
bq78412 data sheet (SLUSAA0)

1.3 I/O Description

Connector / Pin Description

CN1/1 Battery Positive Terminal, BATT+

CN1/2 Battery Positive Voltage Sense, VS

CN1/3 Battery Negative Terminal, BATT–
CN2/1 Sense Voltage Positive Terminal, RS+

CN2/2 Sense Voltage Negative Terminal, RS–
CN3/1 UART RX

CN3/2 UART TX

CN3/3 UART GND

CN3/4 UART SD

CN3/5 UART Power, V+

Intel Core is a trademark of Intel Corporation.
Windows is a trademark of Microsoft Corporation.
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1.4 bq78412EVM and USB-to-Serial Adapter Boards

A picture of the bq78412EVM board is shown in Figure 1. The voltage and current measurement
connectors are on the right side. The UART interface connector is on the left side and the IRDA
transceiver is below this. Bar graph and status LEDs are driven by two shift register chips, which are
placed at the right side of the bq78412.

Figure 1. bq78412EVM Board

The USB-to-Serial Adapter board is shown in Figure 2. The mini-USB connector is on the left side, and
the UART connector is at the bottom.

Figure 2. USB-to-Serial Adapter Board
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1.5 Recommended Operating Conditions

Min Typ Max Unit

Battery Voltage (VBAT+) 4 12 26 V

Sense Voltage (VRS+ – VRS–) –0.16 0.16 V

Terminal Voltage (VRS+, VRS–) –0.3 26 V

Operating Temperature 0 85 °C

2 Software Installation

2.1 Personal Computer Requirements
1. Intel Core™ 2 Duo 1.66-GHz processor or better recommended
2. Windows™ XP SP2 (software has not been tested with Windows Vista/Windows 7)
3. Available USB port
4. .NET Framework version 2.0

2.2 Installing the bq784XX Evaluation Application (GUI)

The bq784xx Evaluation Application is distributed as a zip file, for example "bq784XX Setup Version
1.0.3.0.zip". To install:

1. Copy the file to a temporary directory, and unzip it.
2. Double-click on the extracted file: bq784XX Setup.msi.
3. Follow installation steps as directed.

NOTE: The installer defaults to installing the software for one user on the PC. If all users are
desired, select "Everyone" when prompted. The installer may prompt the user to install the
latest version of the .NET Framework if this is not already installed or if the version is older
than required.

2.3 Installing the FTDI USB-to-Serial Adapter Driver

An FTDI driver must be installed for the USB-to-Serial Adapter. The latest drivers are located on the FTDI
Web site. Install the USB-to-serial drivers per the FTDI installation guides given at
http://www.ftdichip.com/Support/Documents/InstallGuides.htm for your operating system.

Typical steps (for Windows XP) follow.

1. Unzip the drivers to a location on your PC.
2. Temporarily disconnect your PC from the Internet (required only for Windows XP SP1 or earlier)
3. Connect the USB-to-Serial Adapter board to a spare USB port on your PC, using a USB-to-mini-USB

cable.
4. The new hardware is detected and a "Found New Hardware Wizard" dialog opens.
5. If prompted "Can Windows connect to Windows Update to search for software?” , select “No, not at

this time” and click “Next”
6. Select "Install from a list or specific location (Advanced)" and click “Next”
7. Select "Search for the best driver in these locations" and enter the file path in the combo-box or

browse to it by clicking the browse button. Once the file path has been entered in the box, click next to
proceed.

8. Click on "Continue Anyway" in the warning on unsigned (non-WHQL certified) drivers.
9. Click "Finish" to complete the installation.
10. This process (from step 4 onwards) is repeated for the second port of the adapter, after another

"Found New Hardware Wizard" dialog box opens.
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3 Hardware Setup

3.1 Hardware Requirements
1. bq78412EVM board (included)
2. TI USB-to-Serial Adapter board (included)
3. USB to mini-USB cable (included)
4. Shunt resistor (typically 1mΩ) with sufficient power rating to carry the charging/load current
5. Battery along with charger and load
6. Cables

3.2 Board Connections and Power-Up Sequence

This section describes the connectors and power up sequence. See Figure 3.

Current Connector: Sense Resistor Connection
The voltage between RS+ and RS– is measured to infer the current through the battery. The following
describes a low-side current sensing scheme, but a high-side current sensing scheme can be used
instead.

• RS+: Connect to junction of sense resistor and battery negative.
• RS–: Connect to other side of sense resistor.

Battery Connector: Battery Power
The voltage applied between BATT+ and BATT– terminals powers the EVM board. VS is used to measure
the battery voltage (referenced to BATT–)

• BATT+: Connect to positive terminal of the battery
• BATT–: Connect to junction between battery negative and the sense resistor.
• VS: Connect to positive terminal of the battery

Change J2 to CN2 and J1 to CN1 in F3.

Figure 3. Battery and Sense Resistor Connections (Low Side current sensing)

HPA616A USB-to-Serial Adapter Board Connector J1. This five-signal connector on the USB-to-serial
adapter has a label at one end called PIN 1. Plug the serial adapter into J1 so that PIN 1 lines up with the
PIN 1 on the bq78412EVM board.

Connection and power up sequence

• Construct the battery and sense resistor circuit as shown in Figure 3.
• Connect the sense resistor circuit to the Current connector.
• Connect battery plus and minus to the Battery connector.
• Connect the USB cable between the PC and the USB-to-Serial Adapter board.
• Insert the USB-to-serial adapter into the UART connector on the bq78412EVM board as shown in

Figure 4.
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Figure 4. Plugging in the HPA616A

3.3 Configuring the bq784XX Evaluation Application Communications

The bq784XX Evaluation Application automatically detects the USB-to-serial interface adapter and
configures itself for the appropriate communications port. Multiple Applications windows can be
simultaneously opened to control multiple devices connected to different USB ports.

3.4 Testing the Installation

The bq784XX Evaluation Application is invoked from the Windows start menu:

Start → All Programs → Texas Instruments → bq784XX → bq784XX Evaluation

Figure 5 shows how the bq784XX Evaluation Application screen looks when the application has been
correctly installed. In particular the status bar at the bottom of the screen should show the COM port that
has been assigned to the serial adapter, the target device as bq78412, and the firmware version.
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NOTE: The view above shown after parameters have been read: Main Menu → Command → Read All
Parameters

Figure 5. bq784XX Evaluation Application Main View

4 bq784xx Evaluation Application Main Screen

The main screen of the bq784XX Evaluation application is divided into four areas as shown in Figure 6.

These areas are:

1. Menu Bar: This is the standard applications menu bar.
2. Battery Status and Polling: Used for configuring the Application for communication with the connected

device and displaying the dynamic battery status.
3. Parameter, Manufacturer Data, etc. display region: Displays the parameters by default. Can be

configured to display the Manufacturer Data, Cumulative Data, and Communications trace data by
clicking on one of the tabs.

4. Parameter Description: Displays a help description for the currently selected parameter.
5. Status Bar: Contains dynamic status information

4.1 Menu Bar Area

The main menu bar provides for File, Command, Communications, Logging and, Help functions.

4.1.1 File Functions

Under the main File menu the following options are available.

1. Save: Allows saving of the Configuration, Parameters, or Battery Chemistry files.
2. Load: Allows loading of the Configuration, Parameters, or Battery Chemistry files.
3. Exit: Exit from the bq784XX Evaluation Application.
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4.1.2 Command Functions

Under the Command menu, the following submenu options are available.

1. Find Target: Searches all available COM ports for the bq78412EVM. This is required if power to the
device has been cycled or if the USB port has been re-enumerated.

2. Seal Device: Changes the seal level. Prompts for the password if going to a lower seal level.
3. Initialize SOC: Displays dialog box prompting for State of Charge value then writes it to the bq78412.
4. Reset: Command provides selection between resetting the bq78412 or resetting the cumulative data

stored on the device.
5. Update Dynamic Data: Refreshes the Voltage, Temperature, RSOC, Current, and Average Current

values in the Battery status display area.
6. Read All Parameters: Reads all of the parameters and displays their values in the Parameters window.
7. Write Pending Changes to Flash: When a parameter has been modified, this command is used to write

the local copy of the changed parameter value to the bq78412 device.
8. Revert All Pending Changes: All pending changes revert to their previous values. Does not undo

changes that have already been written to the bq78412.
9. Start Polling: Starts polling the device at the set polling rate.
10. Stop Polling: Stops polling.

4.1.3 Communications Functions

Under the Communications menu the following options are available:

1. Enable Monitor: This enables the logging of the raw communication between the Application and the
device to the Communications tab. This is provided as an aid for debugging the communication.

2. Clear Log: Clears the log in the Communications tab.

4.1.4 Logging Functions

Under the Logging menu three submenu options are available.

1. Setup: A log file can be created or browsed to when polling is enabled. Options are provided for over
writing an existing log file and inclusion of cumulative data in the log file.

2. Start: Starts the logging of polled data.
3. Stop: Turns off logging.

4.1.5 Help Functions

Under the Help menu one submenu option is available.

1. About: Displays version information.
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Figure 6. bq784XX Evaluation Application Screen Regions

4.2 Battery Status and Polling Area

This area is used for:

• configuring the communication from the application to the device like polling frequency, baud rate of
the communication address of the bq78412 device to be connected to.

• displaying the battery dynamic status variables such as voltage, current, etc.
• displaying the battery status word.

4.2.1 Polling and Device Address Functions

The following configure polling.

1. Address: Selects the address of the device being polled, default is 0xFF. For successful
communication, this should match the address set in the device.
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2. Baud rate : Selects the baud rate of the communication. For successful communication, this should
match the baud rate set in the device.

3. Polling ►: Starts the polling.
4. ║: Pauses the polling
5. Rate: Selects the polling interval in seconds. Fast indicates the fastest possible rate dictated by OS

transactions.

When polling is active the POLL ■ indicator blinks yellow.

When logging is enabled the LOG ■ indicator is green.

4.2.2 Battery Status Functions

The following dynamic battery status information is displayed.

1. Voltage
2. Temperature
3. Current
4. Average Current
5. RSOC: Relative State of Charge
6. Status – The Battery Status Word. By clicking on each box, the meaning of the status bit is

displayed. When the status bit is active, the color changes to gold.

Under Cell Data the following information is displayed

1. RemainingCapacity
2. FullChargeCapacity
3. RunTimeToEmpty
4. CycleCount
5. DeratedFCC
6. AccumulatedMissedCharge

Even if the polling rate is set high, the cell data only changes when the accumulated charge changes by
0.1 Ah.

See Section 9 for descriptions of the terminology used.

4.3 Parameters, Manufacturer Data, Cumulative Data, and Communication Trace Display
Area

This region is used for displaying parameters, manufacturer data, cumulative data, and the
communications trace data. The user can change the view by clicking on the corresponding tab.

4.3.1 Parameters Tab

The Parameters Tab shows the values of all the parameters used to configure the device. Any parameter
can be highlighted and its description is automatically shown in the Parameter Description window at the
bottom of the screen. The parameter values can be queried from the device using Command → Read All
Parameters menu option. A parameter value can be changed by double clicking on the parameter value.
This brings up a dialog box. All changed parameters are local to the bq784XX Evaluation Application until
written to the bq78412 by Command → Write Pending Changes to Flash. Depending on the present
seal level, some parameters may be read only (depicted by the icon on the left of the parameter name).
The value of these cannot be changed. The parameters that cannot be read in the current seal level do
not show up in the display.
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Figure 7. Parameter Change View
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4.3.2 Manufacturer Data Tab

The Manufacturer Data Tab operates in the same manner as the parameter display. Values of the
Manufacturer Data items can be changed by following the same procedure as that in the previous section.

The values stored do not influence the operation of the device and can be used as desired by the
manufacturer. All the items have hexadecimal values and the encoding of the values needs to be done by
the user. A suggested use and packing format is given in the description, but the user is free to use these
as desired.

The items can be written to only in seal levels 0 and 1. They can be read in all 3 seal levels.

Figure 8. Manufacturer Data Tab
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4.3.3 Cumulative Data Tab

The Cumulative Data Tab shows the real time cumulative usage data from the device. This is read from
the device at the polling rate set in the "Battery Status and Polling" section. Note that all the items in this
tab are read only. For more details on the items displayed, please refer to the section on "Cumulative
Usage Data" in the device datasheet.

For ease of interpretation, the value from the "Time Counters" that count in steps of 6 min are scaled by 6
to directly show the time in minutes. Similarly, the DoD10Count DoD0Count values (that count in steps of
16) are scaled by 16 and the cumulative charge counters are scaled by 16.

Figure 9. Cumulative Data Tab
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4.3.4 Communications Trace Tab

The Communications Trace Tab shows all messages between the bq784XX Evaluation Application and
the bq78412 device. SDO contains the raw packets sent from the computer to the device and SDI
contains the raw packets received by the computer from the device. For more details, refer to the
"Command syntax" in the device datasheet.

It is recommended that the communications trace be turned off when logging is enabled.

Figure 10. Communications Trace Tab

4.4 Parameter Description Area

This area shows the description of the parameter selected in the Parameter Tab, Manufacturer Data tab or
Cumulative Data Tab. This information is also available in the device data sheet.

4.5 Status Bar

The bottom of the window contains the status bar which displays the current status of the User-Interface. It
contains the following information :

1. COM port number of the computer that virtual USB-to-serial converter is currently connected to. More
details on the COM port can be accessed from the device manager of the OS.

2. Name of the device connected to.
3. Version of the firmware in the device.
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4. Number of broadcast packets received.
5. Current Seal level. (0, 1 or 2)
6. Logging status. If logging is active, the log file name.

5 bq78412 Parameter Setting and Start-Up

Use the following steps to initialize the bq78412.

1. Load the Chemistry file for the battery: File → Load → Chemistry → Select. Select the .xml chemistry
file. This step can be bypassed if a chemistry file has not been generated. A default chemistry file is
then used (which has lower accuracy).

2. Set the parameters as desired. Typical parameters that need to be set:

(a) Design capacity: set the specified capacity of the battery
(b) P-scale factor (part of Chemistry file)
(c) Current average time: can be set lower than the 300-s default (e.g., 120 s).
(d) End-of-Discharge voltage: set slightly higher than the inverter cutoff voltage.
(e) Charge time: set slightly lower than the time required to fully charge the battery.

3. Write parameters using Command → Write Pending changes to Flash.
4. Apply software reset: Command → Reset → Device
5. Set the charge level of the battery: Command → Initialize SOC: Set to 100% for fully charged battery.

6 Common Tasks

The following are some common task to perform for the bq78412EVM board.

6.1 Setting Up Logging

The following steps describe how to set up the logging.

1. Execute Logging → Setup.
2. In the pop-up menu, provide the log filename.
3. If required, tick the options for over-writing the log file if it already exists and the option for inclusion of

cumulative data in the log file.
4. Ensure that polling is turned on at the desired rate in the Battery Status and Polling section.
5. Execute Logging → Start
6. To stop logging, execute Logging → Stop. Note that due to buffering by the operating system, the last

section of this file may be written only after this command is executed.

6.2 Setting Up the Device to Broadcast

The following steps describe how to set up the device to broadcast.

1. Turn off Polling.
2. Double-click on the value of the DeviceConfiguration1 parameter.
3. Turn on bit 0 to enable broadcast.
4. Set bits {9:6} appropriately to change the broadcast interval, if required (default = 20 s).
5. Save the value and execute Command → Write Pending Changes to Flash.
6. The battery status now gets updated at the broadcast rate.
7. To monitor the raw communication, execute Communications → Enable Monitor and switch over to the

Communications tab.
8. To turn off the broadcast, follow a similar sequence, and turn off bit 0 in the DeviceConfiguration1.

6.3 Configuring for IrDA Mode of Communication

The following steps describe how to configure for IrDA mode of communication.

1. Connect to the device on UART (plug in the HPA616A board).
2. Double-click on the value of the DeviceConfiguration1 parameter.
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3. Set bits {13,12} to {0,1}.
4. Save the value and execute Command → Write Pending Changes to Flash.
5. Communication to the device is now hampered.
6. Unplug the HPA616A board and place it so that the IrDA transceivers on the two boards are in the

line-of-sight of each other. Optionally, they can be held at a distance of approximately 3 cm from each
other by using the supplied mounting screws.

7. Execute Command → Find Target.

6.4 Changing the Device Address

The following steps describe how to change the device address.

1. Double-click on the value of the MultiDropAdr parameter.
2. Change the value as desired. Securely store this value for future use because reset is not possible.
3. Save the value, and execute Command → Write Pending Changes to Flash.
4. Communication to the device is now hampered.
5. Change the address (pulldown menu) in the Battery Status section to match the value set in the

device.
6. Execute Command → Find Target.

6.5 Changing the Baud Rate

The following steps describe how to change the baud rate.

1. Note that the 1200-baud rate is supported only with the UART mode on the EVM board. Changing the
baud rate to 1200 while communicating with the IrDA mode renders the EVM inoperable.

2. Double-click on the value of the DeviceConfiguration1 parameter.
3. Set the bit to 1 for 1200 baud or 0 for 9600 baud.
4. Save the value, and execute Command → Write Pending Changes to Flash.
5. Communication to the device is now hampered.
6. Change the BAUD Rate (pulldown menu) in the Battery Status section to match the value set in the

device.
7. Execute Command → Find Target.

6.6 Rescaling an Existing Chemistry File

The following steps describe the procedure to generate a Chemistry file optimized for the given battery
capacity, from another which is optimized for a different battery capacity. For better accuracy, use a
Chemistry file that is optimized for the particular chemistry of the battery and the battery capacity. If a
Chemistry file that is optimized for the battery chemistry is not available, the default Chemistry file can be
used, although giving slightly lower accuracy. Chemistry table generation based on customer battery
characterization is needed to achieve highest accuracy. Contact kal@ti.com for assistance with this
process.

1. Note that the default chemistry file is optimized for 150-Ah battery capacity and rated current is 7.5 A.
2. Invoke the Chemistry File Generator Tool using File → Chemistry Generator
3. Select the option to Rescale an existing Chemistry File
4. In the Rescale menu, fill in the following:

• Browse to the input Chemistry File.
• Specify the Battery Capacity for which the input chemistry file is optimized.
• Specify the current for which the battery capacity of the input chemistry file is rated. (For example,

if the battery capacity is 150 Ah at C/10 rate, the rated current is 15 A.)
• Specify the name of the output Chemistry File (this is placed in the same directory as the input file,

with a .xml extension). .
• Specify the Battery Capacity for which the output chemistry file is to be optimized.
• Specify the current at which the battery capacity of the output chemistry file is to be rated. (For

example, If the battery capacity is 80 Ah at C/10 rate, the rated current is 8 A.)
5. The output Chemistry File is then generated.
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6. Load the output Chemistry File by executing File → Load → Chemistry.
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7 Bill of Materials and Schematics

This sections contains the bill of materials for the HPA615A board and the HPA616A board.

7.1 HPA615A Bill of Materials

Table 1. HPA615A Bill of Materials

Count RefDes Value Description Size Part Number MFR

1 PCB Printed Circuit Board 4 Layer 49.5mm x 111.8mm HPA615 Any

7 C1-2 C4 C8-9 0.1 µF Capacitor SMT Ceramic X7R 50V ±10% 603 Standard Standard
C11-12

1 C3 2.2 µF Capacitor Ceramic 50V Y5V +80/–20% 805 Standard Standard

2 C5 C10 1.0 µF Capacitor SMT Ceramic 10V X5R +/–10% 603 Standard Standard

1 C6 4.7 µF Capacitor SMT Tantalum ±10% 16V 3528-21 (EIA) Standard Standard

1 C7 0.01 µF Capacitor SMT Ceramic X7R 25V ±10% 603 Standard Standard

2 C13-14 18 pF Capacitor Ceramic SMT 50V C0G 5% 603 Standard Standard

1 CN1 Terminal Block Header 3 Position 3.5mm 16-28 39357-0003 Molex
AWG

1 CN2 Terminal Block Header 2 Position 3.5mm 16-28 39357-0002 Molex
AWG

1 CN3 5 Pos. Header 0.100", Gold, Vertical 90120-0765 Molex

6 D1-3 D12 D14 LED SMT Red Diffused 603 SML-LX0603IW-TR Lumex
D16

6 D4-6 D11 D13 LED SMT Green Diffused 603 SML-LX0603YW-TR Lumex
D15

4 D7-10 LED SMT Yellow Diffused 603 SML-LX0603GW-TR Lumex

1 D18 Diode Schottky 0.5A, 400mW, Vf<385mV SOD-123 MBR0540-TP Micro Comm Co

1 Q1 Transistor NPN Silicon Planar 600mA SOT-223 PZT2222AT1G ON Semi

1 Q2 Transistor NPN 100mA SOT-23 BC846ALT1G ON Semi.

1 Q3 MOSFET P-Channel PowerTrench –2.3A ±20Vgs SOT-23 (TO-236) Si2319DS Vishay

3 R1-2 R18 47K Resistor Ceramic SMT 1/10W 5% 603 Standard Standard

22 R3 R5-6 R8-13 100 Resistor Ceramic SMT 1/10W 5% 603 Standard Standard
R16 R19 R22-28
R30-33

2 R4 R7 3.3K Resistor Ceramic SMT 1/10W 5% 603 Standard Standard

2 R14-15 10 Resistor Ceramic SMT 1/10W 5% 603 Standard Standard

2 R17 R29 100K Resistor Ceramic SMT 1/10W 5% 603 Standard Standard

1 R20 1.0M Resistor Ceramic SMT 1/10W 5% 603 Standard Standard

1 R21 10K Resistor Ceramic SMT 1/10W 5% 603 Standard Standard

18 TP1-18 Test Clip Point Black 0.040" Dia. Hole 5001 Keystone

1 U1 Lead Acid Battery Monitor and Gas Gauge TSSOP-44 BQ78412DDW Texas Instruments

1 U2 IrDA Transceiver TOP VIEW 6mm x 3.1mm x 1.9mm TFBS4711-TT1 Vishay

2 U3-4 IC Shift Register Serial 8 Bit 14-TSSOP SN74HC164PWR Texas Instruments

1 XT1 Piezo Buzzer Round PC Mount 12.2mm Dia x 9.5mm H PB-12N23P-03Q Mallory Sonalert
Products

1 Z2 Diode Zener SMT 12V, 500mW, Cathode Band SOD-123 BZT52C12-7-F Diodes, Inc
Mark

1 XT2 Crystal SMT Cylinder 8.000 MHz 18pF 0.118 x 0.346" CMR309T-8.000MABJ-UT Citizen Finetech
Miyota

0 X5 DNP PCB Feature - Solderbridge None None None

1 USB to UART/iRDA Adapter PCB Assembly HPA616

Notes: 1. These assemblies are ESD sensitive, ESD precautions shall be observed.

2. These assemblies must be clean and free from flux and all contaminants. Use of no clean flux is not acceptable.

3. These assemblies must comply with workmanship standards IPC-A-610 Class 2.

4. Parts with Manufacturer part numbers cannot be substituted without prior approval. All other components can be substituted with equivalent MFG's components.

5. DNP = Do Not Populate.
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Figure 11. HPA615A Schematic
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www.ti.com Bill of Materials and Schematics

7.2 HPA616A Bill of Materials

Table 2. HPA615A Bill of Materials

Count RefDes Value Description Size Part Number MFR

1 PCB Printed Circuit Board 81.3mm x 44.7mm HPA616 Any

2 C1 C4 0.01 µF Capacitor SMT Ceramic 50V X7R +/-10% 603 Standard Standard

2 C2 C9 1.0 µF Capacitor SMT Ceramic 10V X5R +/-10% 603 Standard Standard

1 C3 10 µF Capacitor SMT Ceramic 10V Y5V +80/-20% 805 Standard Standard

2 C5-6 22 pF Capacitor SMT Ceramic 50V C0G +/-5% 603 Standard Standard

3 C7-8 C11 0.1 µF Capacitor SMT Ceramic 50V X7R +/-10% 603 Standard Standard

1 C10 4.7 µF Capacitor SMT Tantalum +/-10% 16V 3528-21 (EIA) 293D475X9016B2TE3 Vishay

1 CN1 Connector, USB Type B, R/A, Mini, RoHS, SMD 9.9mm x 9.0mm x 3.95mm 1734035-2 Tyco

1 CN2 5 Pos. Header 0.100", Gold, R/A, Female 0.100" PPPC051LGBN-RC Sullins

3 D1-2 D4 LED SMT Green Diffused 603 SML-LX0603GW-TR Lumex

2 D3 D5 LED SMT Red Diffused 603 SML-LX0603IW-TR Lumex

1 F1 220 Ohm Ferrite SMT 603 BLM18AG221SN1D muRata

2 R1 R10 0 Resistor SMT 1/10W +/-5% 603 Standard Standard

2 R2-3 453 Resistor SMT 1/10W +/-5% 603 Standard Standard

3 R4-6 100K Resistor SMT 1/10W +/-5% 603 Standard Standard

4 R7-8 R11-12 100 Resistor SMT 1/10W +/-5% 603 Standard Standard

1 U1 IC DUAL USB Port TVS 8PDIP SN75240P Texas Instruments

1 U2 IC USB to Serial 28-SSOP FT232RL FTDI

1 U3 IC SIR ENDEC IRDA 115.2K 5V Tolerant SO16L TOIM4232 Vishay

1 U4 IrDA Transceiver Top View Version 6mm x 3.1mm x 1.9mm TFBS4711-TT1 Vishay

1 Y1 Crystal SMT 3.6864 MHz 20pF HC-49/US-SM ECS-36-20-5PDN-TR ECS, Inc.

1 Z1 Zener Diode 5.1V 500mW SOD-123 BZT52C5V1-7-F Diodes, Inc

0 TP1-TP5 Test Point N/A N/A

2 Standoff, Nylon, male to female, 6-32 Thread Hex 1.0" Long 4820 Keystone
Electronics

2 Screw, Nylon, 6-32, .375 inch NY PMS 632 0038 PH B&F Fastener

2 Nut, Nylon, 6-32 NY HN 632 B&F Fastener

1 CABLE USB Cable, 5 pin B Mini Male to type A Male, 2M AK672M/2-2 Assman Electronics

Notes: 1. These assemblies are ESD sensitive, ESD precautions shall be observed.

2. These assemblies must be clean and free from flux and all contaminants. Use of no clean flux is not acceptable.

3. These assemblies must comply with workmanship standards IPC-A-610 Class 2.

4. Parts with Manufacturer part numbers cannot be substituted without prior approval. All other components can be substituted with equivalent MFG's components.

5. STANDOFFs screws and CABLE to be provided loose in ESD bag.

19SLUU489–May 2011 bq78412EVM Board Quick-Start Guide
Submit Documentation Feedback

Copyright © 2011, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUU489


MTHOLE6_156DIA MTHOLE6_156DIA

ta
n
ta

lu
m

0

U
S
B

R
E
S
E
T
=

A
C
T
IV

E
 H

IG
H

TOPVIEW

F
E
R
R
IT

E

1
T
X
D

2
D

T
R
#

3
R
T
S
#

4
V
C
C
IO

5
R
X
D

6
R
I#

7

GND

8
N

C
9

D
S
R
#

1
0

D
C
D

#

1
1

C
T
S
#

1
2

C
B
U

S
4

1
3

C
B
U

S
2

1
4

C
B
U

S
3

1
5

U
S
B
D

P

1
6

U
S
B
D

M

1
7

3
V
3
O

U
T

18
GND

1
9

R
E
S
E
T
#

2
0

V
C
C

21
GND

2
2

C
B
U

S
1

2
3

C
B
U

S
0

2
4

N
C 25

AGND

26
TEST

2
7

O
S
C
I

2
8

O
S
C
O

U
2

F
T
2
3
2
R
L

C
3

1
0
u
F

D
3

D
2

R
3

4
5
3

C
4

0
.0

1
u
F

R
8

1
0
0

C
8

0
.1

u
F

C
1
0

4
.7

u
F

R
1
2

1
0
0

T
P
5
-1

T
P
4
-1

1
R
E
S
E
T

2
B
R
/D

3
R
D

_
2
3
2

4
T
D

_
2
3
2

8
V
C
C
_
S
D

7
X
1

6
X
2

5
G

N
D

9
T
D

_
L
E
D

1
0

R
D

_
L
E
D

1
1

N
C

1
2

S
1

1
3

S
2

1
4

T
D

_
IR

1
5

R
D

_
IR

1
6

V
C
C

U
3

T
O

IM
4
2
3
2

R
6

1
0
0
K

C
7

0
.1

u
F

R
4

1
0
0
K

C
6

2
2
p
F

C
5

2
2
p
F

R
5

1
0
0
K

Y
1

3
.6

8
6
4
 M

H
z

D
5

D
4

R
7

1
0
0

R
1
1

1
0
0

C
2

1
.0

u
F

1
0
V
D

C

1
GND

2
C

3
GND

4
D

5
GND

6
B

7
GND

8
A

U
1

S
N

7
5
2
4
0
P

Z
1

5
0
0
m

W

5
.1

 V
D

C

D
1

R
2

4
5
3

1
V
B
U

S
2

D
-

3
D

+
4

ID
5

G
N

D

6

SHELL
7

SHELL
8

SHELL
9

SHELL

C
N

1

1
7
3
4
0
3
5
-2

T
P
3
-1

C
1

0
.0

1
u
F

F
1

2
2
0
 O

h
m

T
P
2
-1

T
P
1
-1

1

2

3

4

5

C
N

2

R
1

0

C
9

1
.0

u
F

1
0
V
D

C

C
1
1

0
.1

u
F

R
1
0

1
IR

E
D

-A

2
T
X
D

3
R
X
D

4
S
D

5
V
C
C

6
G

N
D

U
4

1
X
1

M
T
H

O
L
E
6
_
1
5
6
D

IA

1
X
2

1
X
3

M
T
H

O
L
E
6
_
1
5
6
D

IA

1
X
4

V
C
C

G
N

D

+
3
V
3

G
N

D

Bill of Materials and Schematics www.ti.com

Figure 12. HPA616A Schematic
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www.ti.com Printed-Circuit Board Art

8 Printed-Circuit Board Art

This section contains the artwork for the HPA615A PCB followed by the artwork for the HPA616A PCB.

Figure 13. HPA615A Top Copper Layer

Figure 14. HPA615A Silkscreen
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Printed-Circuit Board Art www.ti.com

Figure 15. HPA615A Layer 1

Figure 16. HPA615A Layer 2
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www.ti.com Printed-Circuit Board Art

Figure 17. HPA615A Layer 3

Figure 18. HPA615A Bottom Copper Layer
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Printed-Circuit Board Art www.ti.com

Figure 19. HPA616A Top Copper Layer

Figure 20. HPA616A Silkscreen

Figure 21. HPA616A Layer 1
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www.ti.com Printed-Circuit Board Art

Figure 22. HPA616A Layer 2

Figure 23. HPA616A Layer 3

Figure 24. HPA616A Bottom Copper Layer
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Definitions of Commonly Used Terms in This Manual www.ti.com

9 Definitions of Commonly Used Terms in This Manual
1. Voltage (output): Instantaneous terminal voltage of the battery.
2. Temperature (output): Instantaneous temperature measured by the on-chip sensor.
3. Current (output): Instantaneous battery current, negative value is a discharge current.
4. Average Current (output): Average battery current, negative value is a discharge current. The

averaging duration is controlled by the CurrentAvgTime parameter.
5. Charge Efficiency (input): This parameter factors in the coulombic efficiency (Ahout/Ahin) of the

battery when charged and discharged according to manufacturers recommendations. Charging current
is multiplied by this value before accumulation for coulomb counting.

6. Chemistry File (input): This is a file generated by TI, based on battery characterization data obtained
from the manufacturer. This describes the variation of the battery capacity with load and temperature.
Using a battery-specific file improves the accuracy of results.

7. Design Capacity (input): This parameter represents the rated capacity of the battery at the rated load
and temperature conditions.

8. FullChargeCapacity or FCC (output): The current value of the capacity of the battery (when fully
charged). This starts off with the value in the DesignCapacity parameter and changes based on
capacity learning and ageing.

9. DeratedFCC (output): Full-charge capacity de-rated for the load current and battery operating
temperature. This is the capacity that the battery is expected to deliver at the given load current and
given operating temperature (when it is full). Note that the value of this equals the FCC when the load
current and battery operating temperature are equal to the load current and operating temperature at
which the battery is rated by the manufacturer, . Also note that this can be higher than the FCC at
temperatures higher than the rated temperature or at loads lower than the rated load.

10. RemainingCapacity (output): The remaining capacity of the battery in Ah at the present load current
and temperature. When the battery is full, this equals the Derated FCC and goes to zero when the
battery cannot deliver any more charge at the present load current and temperature. Note that even
when the RemainingCapacity is zero, the battery can still deliver charge if the load current is reduced.
In such a case, the DeratedFCC increases (based on the reduced load current) and the
RemainingCapacity shows a corresponding increase.

11. RSOC (output): Relative State of Charge (RemainingCapacity/DeratedFCC). This indicates the
fraction of charge that the battery can currently deliver relative to the maximum it can deliver at the
present load and temperature.

12. RunTimeToEmpty (output): The estimated time to empty based on the present discharge rate,
voltage, and temperature. Note that this assumes that power is drawn from the battery at a constant
rate.

13. CycleCount (output): Represents the number of charge and discharge cycles undergone by the
battery. This equals the ¢¢TotalAhout/DesignCapacity. Thus, partial discharges also get accumulated.

14. AccumulatedMissedCharge (output): Total missed charge due to discharges starting before battery
has reached full charge. This represents the cumulative difference of the Ahout and Ahin from the last
time the battery was fully charged.
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Evaluation Board/Kit Important Notice

Texas Instruments (TI) provides the enclosed product(s) under the following conditions:

This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION
PURPOSES ONLY and is not considered by TI to be a finished end-product fit for general consumer use. Persons handling the
product(s) must have electronics training and observe good engineering practice standards. As such, the goods being provided are
not intended to be complete in terms of required design-, marketing-, and/or manufacturing-related protective considerations,
including product safety and environmental measures typically found in end products that incorporate such semiconductor
components or circuit boards. This evaluation board/kit does not fall within the scope of the European Union directives regarding
electromagnetic compatibility, restricted substances (RoHS), recycling (WEEE), FCC, CE or UL, and therefore may not meet the
technical requirements of these directives or other related directives.

Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30
days from the date of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY
SELLER TO BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all
claims arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to
take any and all appropriate precautions with regard to electrostatic discharge.

EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER
FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

TI currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive.

TI assumes no liability for applications assistance, customer product design, software performance, or infringement of
patents or services described herein.

Please read the User’s Guide and, specifically, the Warnings and Restrictions notice in the User’s Guide prior to handling the
product. This notice contains important safety information about temperatures and voltages. For additional information on TI’s
environmental and/or safety programs, please contact the TI application engineer or visit www.ti.com/esh.

No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used.

FCC Warning

This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION
PURPOSES ONLY and is not considered by TI to be a finished end-product fit for general consumer use. It generates, uses, and
can radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant to part 15
of FCC rules, which are designed to provide reasonable protection against radio frequency interference. Operation of this
equipment in other environments may cause interference with radio communications, in which case the user at his own expense
will be required to take whatever measures may be required to correct this interference.

EVM Warnings and Restrictions

It is important to operate this EVM within the input voltage range of 4 V to 26 V and the output voltage range of 0 V to 5 V .

Exceeding the specified input range may cause unexpected operation and/or irreversible damage to the EVM. If there are
questions concerning the input range, please contact a TI field representative prior to connecting the input power.

Applying loads outside of the specified output range may result in unintended operation and/or possible permanent damage to the
EVM. Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the load
specification, please contact a TI field representative.

During normal operation, some circuit components may have case temperatures greater than 85° C. The EVM is designed to
operate properly with certain components above 85° C as long as the input and output ranges are maintained. These components
include but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors. These types of
devices can be identified using the EVM schematic located in the EVM User's Guide. When placing measurement probes near
these devices during operation, please be aware that these devices may be very warm to the touch.
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.

TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.

TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications

Audio www.ti.com/audio Communications and Telecom www.ti.com/communications

Amplifiers amplifier.ti.com Computers and Peripherals www.ti.com/computers

Data Converters dataconverter.ti.com Consumer Electronics www.ti.com/consumer-apps

DLP® Products www.dlp.com Energy and Lighting www.ti.com/energy

DSP dsp.ti.com Industrial www.ti.com/industrial

Clocks and Timers www.ti.com/clocks Medical www.ti.com/medical

Interface interface.ti.com Security www.ti.com/security

Logic logic.ti.com Space, Avionics and Defense www.ti.com/space-avionics-defense

Power Mgmt power.ti.com Transportation and www.ti.com/automotive
Automotive

Microcontrollers microcontroller.ti.com Video and Imaging www.ti.com/video

RFID www.ti-rfid.com Wireless www.ti.com/wireless-apps

RF/IF and ZigBee® Solutions www.ti.com/lprf

TI E2E Community Home Page e2e.ti.com
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